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BAB I 

SISTEM INFORMASI GEOGRAFIS 

1.1 Pendahuluan 

Pengetahuan spatial/keruangan adalah pengetahuan yang 

selalu berhubungan dengan ruang muka bumi. Karena itu, kata 

tanya yang selalu memulai masalah dalam keruangan adalah di 

mana (where), apa (what), kapan (when), bagaimana (how) dan 

mengapa (why). Dalam satu kalimat, pertanyaan permasalahan 

dalam geografi adalah mengapa persebaran keruangan berbentuk 

seperti itu?. Semua kata tanya atau pertanyaan itu dijawab dan 

dijelaskan dalam bentuk peta. 

Kemajuan teknologi telah sangat membantu para ilmuan 

(geograf, geodet, geolog, ahli komputer, dan sebagainya) dalam 

memenuhi keingintahuannya akan sesuatu. Penyajian dan 

pengolahan data yang dilakukan secara manual, kini dapat 

dilakukan dengan teknologi komputer. Hasil yang didapat lebih 

tepat dan cepat. Teknologi komputer yang makin maju juga 

memberikan warna baru dalam sajian informasi keruangan. Peta 

yang biasanya disajikan dalam dua dimensi, kini dapat disajikan 

dalam tiga dimensi atau lebih. 

Bab 1 
 

SISTEM INFORMASI GEOGRAFIS 
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Sajian informasi yang dihasilkan oleh teknologi komputer 

berupa sajian data keruangan secara dijital. Tujuan penyajian data 

seperti itu adalah untuk membantu pengguna jasa melakukan 

analisis berbagai gejala keruangan secara tepat guna. Karena itu 

ketepatan hasil merupakan tujuan utamanya. Tetapi gejala yang 

terjadi di atas ruang muka bumi amatlah rumit sehingga perlu 

disederhanakan. Proses penyederhanaan ini dilakukan dengan 

melihat beberapa hal, antara lain kemampuan perangkat dan 

kesederhanaan penggunaan perangkat komputer, serta dapat 

memenuhi tujuan penggunaannya. 

Secara definisi, Sistem Informasi Geografis (SIG) adalah 

suatu perangkat untuk mengumpulkan, menyimpan, 

menampilkan, dan mengkorelasikan data spatial dari fenomena 

geografis untuk dianalisis dan hasilnya dikomunikasikan kepada 

pemakai data, bagi keperluan pengambilan keputusan (Gunawan, 

1995, dirangkum dari beberapa literatur). Dengan definisi tersebut, 

SIG jelas mempunyai karakteristik sebagai perangkat pengelola 

basis data (Database Management System-DBMS), sebagai 

perangkat analisis keruangan (spatial analysis), dan juga sekaligus 

proses komunikasi untuk pengambilan keputusan. 

Keunikan SIG jika dibandingkan dengan sistem 

pengelolaan basis data yang lain adalah kemampuannya untuk 

menyajikan inormasi spatial maupun non-spatial secara bersama-

sama. Cara penyajian dijital dari fenomena geografis di dalam 
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komputer, dapat dilakukan dalam dua macam bentuk (format) 

yaitu: raster (grid-cell) dan vektor. Format raster adalah penyajian 

obyek dalam bentuk rangkaian cell atau elemen gambar (picture 

element/pixel). Dalam format ini, suatu garis misalnya, akan 

disajikan dalam bentuk rangkaian cell/pixel. Sedangkan format 

vektor adalah penyajian dalam bentuk rangkaian koordinat. Garis 

dalam format vektor misalnya, akan disajikan dalam bentuk 

koordinat dari kedua ujungnya. Sebagai suatu perangkat, SIG 

terdiri dari baik perangkat keras (hardware) maupun perangkat 

lunak (software). Dari segi perangkat keras maka komponen 

utama SIG adalah alat masukan (input) data, unit komputer 

sebagai alat pengolah data, dan alat penghasil keluaran (output) 

dan jaringan komunikasi. 

Pada saat ini aplikasi SIG sudah banyak 

diimplementasikan, baik yang menyangkut physical, sosial, 

budaya, keamanan & pertahanan, maupun aplikasi yang sifatnya 

multi disiplin, seperti perencanaan dan evaluasi tata ruang, urban 

planning, kelautan, kehutanan, dsb. Pada tulisan ini dijelaskan 

mulai dari dasar-dasar SIG, terutama yang menyangkut 

komponen SIG, cara pengolahan data SIG, beberapa analisis dalam 

SIG dalam perencanaan sebuah aplikasi yang berhubungan 

dengan kelautan dan pesisir. 
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1.2 Komponen SIG 

1.2.1 Sumber Daya Manusia (SDM) 

SIG adalah teknologi di garis depan dan merupakan 

interdisiplin yang membutuhkan sumberdaya manusia yang 

berkualitas untuk tiap-tiap tingkatan dalam pekerjaannya. 

Secara umum sumberdaya manusia yang dibutuhkan adalah 

sebagai berikut: 

Staf operasional yang terdiri dari end user(orang yang 

bertugas untuk membuat sistem menghasilkan keuntungan, 

termasuk mengantisipasi segala kemungkinan selama 

berlangsungnya pekerjaan), kartografer (bertugas melayout 

peta sehingga jelas dan mudah dimengerti), data capturer 

(bertugas mengkonversi peta menjadi bentuk digital), 

potential users (orang yang mampu mengoperasikan teknologi 

SIG). 

Staf analis profesional terdiri dari: analist (orang yang 

menganalis berdasarkan pengetahuan dan pengalaman di 

bidang SIG), system administrator (bertugas menjaga, merawat 

perangkat keras dan perangkat lunak dari komputer yang 

digunakan untuk pekerjaan), progrmmer (bertugas 

menterjemahan aplikasi khusus untuk keperluan SIG 

menjadi program yang bisa dijalankan), data base administrator 

(orang yang mengatur fenomena-fenomena geografi ke 
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dalam bentuk layerlayer, mengidentifikasi sumber data, 

mendokumenkan informasi yang terkandung dalam data 

base sehingga dapat dibaca sistem dan dapat 

terintegrasikan), super operator (orang yang ahli dalam semua 

perangkat keras dan perangkat lunak dalam SIG) Manajer 

perorangan yang bertanggungjawab atas perkembangan 

harian dari pekerjaan yang sedang dikerjakan yang mengatur 

kerja tim, mengatur hasil output/produksi yang dibutuhkan 

seperti layaknya sebuah organisasi. Selain itu ada juga 

keahlian SIG berdasarkan tingkatan keahlian selain ahli 

dalam operasi/operator juga dalam manajemen SIG-nya, 

seperti gambar 2. dibawah ini. 

1.2.2 Perangkat Keras (Hardware) 

Perangkat keras yang mendukung analisis 

spatial/geografi dan pemetaan sebenarnya, tidak jauh 

berbeda dengan perangkat keras lainnya yang digunakan 

untuk mendukung aplikasi-aplikasi bisnis dan sains. 

Perbedaannya, jika ada terletak pada kecenderungannya 

yang memerlukan perangkat (tambahan) yang dapat 

mendukung presentasi grafik dengan resolusi dan kecepatan 

yang tinggi, dan mendukung operasi-operasi basis data yang 

cepat dengan volume data yan besar. Perangkat keras SIG 

memiliki pengertian perangkat-perangkat fisik yang 

digunakan oleh sistem komputer. Perangkat keras ini pada 
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umumnya mencakup : CPU, RAM, Storage, Input device, 

Output device dan Peripheral lainnya. Alat masukan (input) 

data yaitu : 

 

Digitizer adalah alat untuk mendigitasi, yaitu proses 

identifikasi titik (point) di peta dan mendaftarkan (registrasi) 

point tersebut ke dalam database digital/file. Hal ini 

merupakan metode yang umum dilakukan untuk konversi 

peta dan citra menjadi bentuk digital. 
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Scanner pada situasi tertentu dapat menggantikan 

proses digitasi, yaitu secara otomatis mengkonversi peta 

hard-copy menjadi bentuk digital. Hal tersebtu dilakukan 

melalui proses "raster to vector", yang menggunakan 

penyinaran dalam proses scan permukaan peta dan 

mengkonversikannya menjadi titik-titik yang tak terhitung 

jumlahnya. Kemudian titik-titik ini tergabung sebagai "raster 

image", yaitu matrik titik-titik ang mempunyai warna hitam 

dan putih dan mempunyai lokasi untuk tiap lokasi yang 

terdapat di peta. Jadi scanner membaca peta, 

mengkonversinya menjadi raster image, kemudian 

menggabungkan kumpulan titik- titik menjadi vector. 

Adapun keakuratan data hasilnya tergantung pada skala 

peta dan resolusi dari scanner. 

Unit komputer sebagai pengolah data SIG pada 

dasarnya hampir sama dengan komputer untuk teknologi 

informasi lainnya, yaitu terdiri dari : CPU (Control Processing 

Unit), RAM (Random Acces Memory), Hardisk (Secondary 

Storage), Keyboard dan mouseserta Monitor 
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1.2.3 Perangkat Lunak (Software) 

Pada sistem komputer modern, perangkat lunak yang 

digunakan tidak dapat berdiri sendiri, tetapi terdiri dari 

beberapa layer. Model layer ini terdiri dari sistem operasi, 

program-program pendukung sistem-sistem khusus (special 

system utilities), dan perangkat lunak aplikasi (Antenucci91). 

Sistem operasi terdiri dari program-program yang 

mengawasi jalannya operasi-operasi sistem dan 

mengendalikan komunikasi-komunikasi yang terjadi 

diantara perangkat-perangkat keras yang terhubung ke 

sistem komputer yang bersangkutan. Special system utulities 

dan perangkat lunak aplikasi yang digunakan untuk 

menjalankan tigas-tugas seperti menampilkan atau mencetak 

peta mengakses program-program sistem operasi untuk 

mengeksekusi fungsi- fungsinya. 
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Sistem operasi mengandung program-program untuk 

manajemen memori, akses sistem, pengendalian komunikasi, 

pengolahan perintah-perintah, manajemen data dan file, dan 

sebagainya. Special system utilities dan program-program 

pendukungnya terdiri dari compiler bahasa pemrograman 

(hampir semua perangkat lunak manajemen data geografi 

(SIG dan CAD) dituliskan dengan menggunakan bahasa 

pemrograman seperti Assembler, Fortran, Basic, C, atau 

C++), device driver (di dalam SIG, device driver pada 

umumnya diperlukan untuk mendukung input dan output 

device seperti digitizer, printer, plotter, dan scanner), utility 

untuk backup data, pustaka fungsi dan prosedur (pustaka 

fungsi dan prosedur seringkali merupakan bagian dari 

sistem operasi yang kemudian dimanfaatkan oleh bahasa 

pemrograman komputer untuk membuat aplikasi SIG), dan 

perangkat lunak komunikasi khusus. Perangkat lunak 

aplikasi terdiri dari word processing, sphread sheet, database, 

presentation, dan aplikasi-aplikasi khusus lainnya seperti SIG. 

Perangkat lunak khusus aplikasi SIG sering 

digunakan untuk menjalankan tugas-tugas SIG. Perangkat 

lunak ini tersedia dalam bentuk paket-paket perangkat lunak 

yang masing-masing terdiri dari multiprogram yang 

terintegrasi untuk mendudkung kemampuan-kemampuan 

khusus untuk pemetaan, manajemen, dan analisis data 
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geografi. Perangkat lunak yang dikembangkan untuk SIG 

secara konseptual terdiri dari dua bagian : paket inti (core) 

yang digunakan untuk pemetaan dasar dan manajemen data, 

dan paket-paket aplikasi yang terintegrasi dengan paket inti 

untuk menjalankan pemetaan khusus dan aplikasi analisis 

geografi. 

Pemilihan perangkat lunak SIG sangat bergantung 

pada sejumlah faktor termasuk tujuan-tujuan aplikasi, biaya 

pembelian dan pemeliharaan, kesiapan dan kemampuan 

personil-personil pengguna adan agen perangkat lunak yang 

bersangkutan. Seperti perangkat keras, ilustrasi mengenai 

kebutuhan perangkat lunak SIG, WGIAC (Wyoming 

Geographic Information Advisor Council) juga telah membuat 

standar umum berikut : 

1. Sistem operasi : berbasiskan UNIX (X Windows) atau 

Windows (Win95, Win98,WinNT) 

2. Model data spatial : raster dan vektor, tetapi dengan 

prioritas tinggi kepada model data spasial vektor 

3. Basis data : jika menggunakan basis data relasional, 

harus sesuai dengan standar SQL atau Structured Query 

Language 

(FIPS 127-2) sebagaimana dideskripsikan di dalam 

sistem-sistem manajemen basis data untuk standar aplikasi-
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aplikasi multiuser. Jika tidak menggunakan basis data 

relasional, maka bsis data tersebut harus mampu melakukan 

aksport/import ke dan dari basis data relasional (SQL). 

1.3 Hubungan SDM dengan Software, Pendidikan, Standarisasi 

dan Kesempatan 

Seperti penjelasan di atas tentang SDM, ada tingkatan 

keahliannya, yaitu op-rator tingkat-1, operator tingkat-2 dan 

manajerial. Hal ini sangat berhubungandengan kemampuan 

seseorang dalam mempelajari baik software maupun 

konsepkonsepnya. Untuk tingkat operator dapat dilihat seperti 

gambar 3 di bawah ini. 

Sedangkan untuk tingkat Manajerial dengan tambahan 

analisis dan aplikasi SIG lanjutan tidak hanya sistem operasi yang 

dikuasasi akan tetapi sudah mengasasi konsep-konsep yang ada. 

Gambaran untuk tingkat manajerial dengan software-nya adalah 

sbb. 

1.4 Pengolahan Data SIG 

Data-data SIG terdiri dari data-data spatial dan data 

tabuler. Data Spatial dapat bersumber pada peta hardcopy, 

fotogrametri, remote sensing, GPS (Global Positioning System) dan 

pemetaan teresterial digital. Sedangkan data tabuler atau tekstual 

dapat bersumber kepada data BPS, hasil survey, studi pustaka, 
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dsb. Data-data tersebut di-input memalui berbagai alat bantu, 

seperti digitizer, scan, dsb. 

Hasil input data kemudian diolah dengan menggunakan 

software SIG yang akhirnya dapat menjadi database SIG. Database 

SIG dapat mempunyai berbagaimacam format dan dapat 

dijadikan analisis berbagai kebutuhan. Hal lain yang juga 

dianggap penting dalam database SIG adalah tentang sistem 

koordinat yangdipakai, yang tujuan sebagai integrasi dari berbagai 

macam data digital SIG. Pada saat ini sistem koordinat yang 

banyak dipakai yaitu sistem koordinat UTM (Universal Tranverse 

Mercator). 

Proses pengolahan data SIG dari sebuah peta (data spatial) 

akan memerlukan proses data yang cukup lama, akan tetapi akan 

lebih cepat untuk di up date datanya dan dicetak dalam berbagai 

macam skala peta dan ukuran kertas. Hasil pengolahan data SIG 

merupakan perpaduan antara data spatial dengan data tabuler 

yang secara visual terlihat pada gambar 6. di bawah ini. 

1.5 Analisis dalam SIG 

Software SIG menyediakan berbagai macam menu analisis 

SIG, antara lain analisis buffer, union (overlay), intersection (overlay), 

network (jaringan) statistik sederhana dan perhitungan (logical 

Boolean) lainnya. Akan tetapi sebetulnya dalam suatu konsep 

spatial (keruangan), dikenal dengan analisis keruangan (spatial), 
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banyak sekali macamnya. Analisis spatial antara lain overlay peta, 

network, tetangga terdekat, difusi, distribusi, kecenderungan. Pada 

intinya analisis spatial ini adalah interaksi di dan antar ruang, baik 

menyangkkut persamaan maupun perbedaan. 

Analisis spatial dalam software SIG tidak semuanya dapat 

diimplementasikan secara teknis dengan menu-menu yang ada. 

Implementasi analisis spatial dilakukan dengan bantuan tabel 

(matriks), peta-peta serta serta hubungan obyek baik dalam satu 

peta maupun antar peta yang menjadi bagian (variabel) dalam 

analisis tersebut. 

Analisis yang akan dibahas dalam buku ajar ini adalah 

analisis dengan menggunakan ArcGIS. Analisis yang dilakukan 

terbatas pada analysis tools dalam Arctoolbox, yang terdiri atas 

Extract, Overlay, Proximity, dan Statistic. Dalam ArcGIS fungsi ini 

analisis ini terbagi lagi dalam banyak fungsi misalnya untuk extract 

kemudian dibagi lagi atas clip, select, split dan table select. Demikian 

juga degan overlay, proximitt dan statistics terdiri atas beberapa 

pilihan analisis. Caranya klik ArcToolbox  

 



14   Universitas Negeri Surabaya | Sistem Informasi Geografis (SIG) 

 

14 

Lalu klik analysis Tools, akan muncul pilihan Extract, 

Overlay, Proximity, Statistic yang kemudian bisa di klik lagi 

untuk memunculkan fungsi-fungsi clip, erase, buffer, atau 

frequency dari masing-masing pengelompokan analisis tersebut 

 

1. Extract (Clip), clip adalah proses memotong satu dataset 

dengan date set lain untuk mendapatkan dataset baru dengan 

bidang luasan sama dengan dataset pemotongnya. 
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Caranya adalah 

a. Buka ArcMap 

b. Buat Workspace Baru 

c. Masukkan dataset misalkan Kaltim_jalan_2006 

d. Masukkan dataset Kabupaten Berau 

e. Pilih menu Geoprocessing 

 

f. Pilih Clip, maka akan muncul kotak dialog untuk diisikan 

dataset yang akan di clip 
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g. Dari dua pilihan diatas dapat disimpulkan bahwa Input 

Feature bisa berupa fitur polygon, line atau point. 

h. Clip feature harus berbentuk Polygon 

i. Output Feature sesuai dengan Input Feature 

2. Overlay (Identity), overlay merupakan salah satu analisis yang 

mendasar dalam GIS, beberapa pertanyaan kunci analisis 

seperti “apa jenis tanaman yang terdapat dalam tanah 
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alluvial?” pertanyaan tersebut dapat dijawab dengan 

melakukan analisis overlay dari layer jenis tanah dan jenis 

vegetasi. Ada beberapa analisis overlay seperti erase, identity, 

intersect, dll 

 

Dalam hal ini akan dibahas langkah pada analisis overlay 

indentity, dimana langkah yang sama digunakan pada 

analisis yang lain. Pengertian yang jelas dapat dilihat dalam 

panduan ArcGIS dengan menggunakan kata kunci overlay. 
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Intersect dilakukan dengan membuka ArcToolbox dan 

Analysis tools 

Lakukan proses overlay Identity yaitu proses overlay 

dimana fitur identify akan disesuaikan dengan area input 

dan akan digabungkan data tabularnya dimasukkan dalam 

dalam fitur input. 

 

Klik Identity, akan terbuka windows 

 

Pada akhir analisis file akan ditampilkan dalam tabel of 

content secara otomatis. 



   Universitas Negeri Surabaya | Sistem Informasi Geografis (SIG)  19 

 

19 

3. Proximity (Buffer), Untuk menjawab pertanyaan mengenai 

jarak biasanya digunakan analisis proximity, misalnya 

pertanyaan “Berapa banyak rumah dari lokasi kantor 

kecamatan?”. Untuk menjawab pertanyaan tersebut 

digunakan analisis proximity dan biasanya menggunakan 

analisis buffer. 

 

Analisis buffer diambil sebagai contoh karena analisis ini 

banyak digunakan, buffer adalah proses analisis dengan 

membuat fitur berdasarkan jarak tertentu dari fitur tertentu. 

 

Pada Arctoolbox pilih Analysis Tools lanjut klik Proximity 

dan klik Buffer 
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Hasilnya akan menjadi seperti berikut 

 

4. Statistic (Frequency), Ada banyak analisis yang 

menggunakan fungsi statistic. Frequency misalnya 

digunakan untuk menghitung jumlah fitur dalam satu layer 

Klik Arctoolbox klik Statistics dan pilih Frequency 
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a. Isikan dengan data yang akan dikalkulasi SK554_Berau_UTM 

b. Pilih data Luas 

c. Klik OK 

 

 

 

 

 

 

 

 

e.  Klik kanan dan buka tabel, maka 

hasilnya sebagai berikut 

d.  Dan data akan ditampilkan dalam 

bentuk tabular 
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1.6 Aplikasi SIG 

Aplikasi SIG terdiri dari aplikasi SIG berbasis IT 

(Information Technology) dan aplikasi SIG berbasis spatial. Aplikasi 

berbasis IT merupakan pengembangan software SIG yang ada 

ataupun perpaduan antara software SIG, database, program dan 

sebagainya. Contoh dari aplikasi ini misalnya Sistem Informasi 

Pengelolaan Sumber Daya Alam Berbasis SIG. Basis spatial pada 

aplikasi SIG banyak sekali kegunaannya, apakah itu untuk 

hidrologi, jalan raya, perkotaan, pertanahan, perencanaan, dsb. 

Contoh dari aplikasi SIG ini misalnya perencanaan tata ruang 

pesisir, merupakan suatu aplikasi SIG multi disiplin dengan 

berbagai macam variabel, mulai kondisi fisik, penggunaan tanah, 

sosial ekonomi masyarakat, sampai kepada aturan kebijakan 

(UU, Perpu,Perda, dsb). 

Tahapan sebuah aplikasi SIG bebasis spatial yaitu 

pembuatan modelling SIG, pengumpulan data, pengolahan data, 

pembuatan matrik untuk analisis, proses analisis dengan konsep 

database, tabel dan data yang dihasilkan, query (jika ada). Dari 

proses tahapan ini di dapat suatu hasil proyek suatu aplikasi SIG. 

1.7 Penutup 

SIG dapat dikatan sebagai sebagai salah satu 'tools' (alat bantu) 

dalam membangun data spatial digital sampai memecahakan 

permasalahan baik berkaitan dengan ruang (spatial) maupun 
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dengan teknologi informasi. Tahapan pada pekerjaan SIG cukup 

panjang, akan tetapi data yang dihasilkan merupakan data yang 

selalu dapat diperbaiki dan di cetak setiap waktu dengan 

berbagai macam skala dan ukuran cetak. Juga data tersebut siap 

untuk integrasikan dengan data spatial yang dibangun oleh 

institusi lain serta sebagai bahan untuk analisis. Proses secara 

detail praktek tahapan pekerjaan SIG ini akan dipelajari dalam 

pelatihan ini dan secara teori proses sebuah aplikasi akan 

diberikan dengan analisis spatial. 
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BAB II 

DATA SIG 

2.1. Data Input 

Data input melibatkan proses digitalisasi baik untuk data 

geografis maupun data atribut. Untuk data atribut seperti 

Spreadsheets (misal: file excel) dan Sistem Informasi / Database. 

Data geografis contohnya pengisian koordinat, Digitizing, dan 

Scanning. Konversi dari peta hardcopy ke peta digital adalah 

kegiatan yang paling menghabiskan waktu dalam GIS karena 

membutuhkan biaya sampai 80% dari total biaya proyek dan 

banyak membutuhkan tenaga, membosankan, dan rawan terjadi 

kesalahan.  

Untuk memasukkan data koordinat dengan keyboard 

seperti data koordinat latitude/longitude dari suatu titik 

diperlukan GPS. Global Positioning System (GPS) dilakukan 

untuk menentukan posisi saat ini menggunakan sinyal yang 

dikirim oleh sejumlah satelit. Pembacaan GPS sudah dalam 

bentuk digital langsung dapat dibaca langsung dari GIS. GPS 

menggunakan sinyal satelit untuk mendapatkan koordinat 

latitude/longitude dengan tepat.  

Bab 2 
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2.2. Data Tabuler 

Selain jenis data spasial terdapat juga data non-spasial 

yang terdiri dari data tabular, narasi, dan teks (anotasi). Data 

anotasi adalah kelengkapan dalam penyajian data spasial, 

seperti nama jalan, nama sungai, nama kota. Data tabular  

tersusun atas record (baris), field / item (kolom) dan mempunyai 

suatu kolom sebagai nomor kunci (key / feature_id) sebagai 

penghubung. Data tabular ini  disusun sebagai model data yang 

disebut DBMS (Database Management System).  Setelah data 

memiliki DBMS yang siap dianalisis atau dipakai maka siap 

digabungkan (join item / link) ke data spasial. 
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BAB III 

SUBSISTEM DATA SIG 
 

3.1. Input 

subsistem ini bertugas untuk mengumpulkan dan 

mempersiapkan data spasial dan atribut dari berbagai sumber. 

Data input bertanggung jawab mengkonversi format data asli ke 

dalam format yang digunakan dalam SIG. Data input meliputi : 

Tabel, laporan, pengukuran lapangan, peta, citra satelit, foto 

udara, data digital, dll. Database yakni ada dua data primer dan 

data sekunder 

3.1.1. Data Primer 

Data primer merupakan data yang diukur 

langsung dengan survey, pengumpulan data lapangan, 

penginderaan jauh. Kita biasanya tidak bisa melakukan 

observasi terhadap distribusi spasial pada wilayah yang 

akan kita pelajari secara keseluruhan sehingga kita perlu 

melakukan pengambilan sampel yakni melakukan 

pengukuran pada beberapa area yang dapat memberikan 

gambaran yang paling sesuai untuk wilayah tersebut.  

Contohnya untuk melakukan penghitungan jumlah 

pohon di dalam hutan, tidak perlu melakukan 

penghitungan di seluruh wilayah hutan. Tetapi bisa 
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dilakukan pengambilan sample dengan melakukan 

penghitungan di beberapa area saja. 

Densitas pengambilan sample menentukan resolusi 

dari data, pengambilan sample yang dilakukan pada interval 

1km akan kehilangan variasi yang lebih kecil dari 1km. 

Beberapa pendekatan standart dalam pengambilan sampel 

ada Random, systematic, dan stratified. Random sampling 

merupakan sampel yang semua tempat dapat dijadikan 

tempat pengambilan sampel. Systematic Sampling 

merupakan titik-titik pengambilan sampel yang diletakkan 

pada interval teratur. Sedangkan, stratified sample 

membutuhkan pengetahuan tentang perbedaan informasi 

spasial untuk tiap bagian wilayah, titik pengambilan sample 

yang lebih banyak diletakkan pada area dengan perbedaan 

variable lebih tinggi. Contohnya untuk melakukan survey 

data penduduk dalam suatu kabupaten, titik-titik 

pengambilan sample di daerah dengan kepadatan penduduk 

lebih tinggi diletakkan lebih banyak.   

 

 

 

 

 

 

      RANDOM SAMPLING    SYSTEMATIC SAMPLING      STRATIFIED SAMPLING 
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3.1.2. Data Sekunder 

Data yang didapat dari sumber yang sudah ada, 

tabel-tabel atau sumber data yang lain. Data ini telah 

banyak tersedia untuk GIS seperti instansi pemerintah 

yang menyediakan data sensus penduduk. Meta-data: 

“data mengenai data” merupakan prosedur yang 

digunakan untuk mengumpulkan data, history dari data, 

akurasi dan standar pengukuran, rencana pengkodean. 

Dibutuhkan baik untuk data spasial maupun data atribut. 

Sumber data sekunder ada tiga yakni data Framework, 

Data Socioeconomic dan Data Environmental.  

Data Framework merupakan data referensi untuk 

menyediakan hubungan dengan data-data lain seperti 

data nama Jalan dan sungai, sedangkan sumber data 

berasal dari survey topografi, survey yang dilakukan 

militer. Data Socioeconomic merupakan data tentang 

penduduk, aktifitas penduduk, ruang dan/atau struktur 

yang digunakan untuk mendukung aktifitas penduduk 

seperti data demografi, migrasi, perumahan, transportasi, 

dan aktifitas ekonomi. Data tersebut memiliki refrensi 

terhadap wilayah administratif, tempat tinggal, dan 

rumah pribadi  
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3.2. Manajemen 

Proses untuk mengkonversi data-data input menjadi out 

put pada subsistem ini mengorganisasikan baik data spasial 

atau atribut ke dalam basis data sehingga mudah ditampilkan, 

di-update, dan diedit 

3.3. Manipulasi dan Analisis 

Subsistem ini menentukan informasi-informasi yang 

dapat dihasilkan oleh SIG. Selain itu, subsistem ini juga 

melakukan manipulasi dan pemodelan data untuk 

menghasilkan informasi yang diharapkan. 

3.4. Output 

Subsistem ini menampilkan atau menghasilkan keluaran 

seluruh atau sebagian basisdata baik dalam bentuk softcopy atau 

hardcopy. Data output berupa Peta, Tabel, Laporan dan 

Informasi digital lain 

Wilayah administratif            Tempat Tinggal/desa      Rumah Pribadi 

3
0
5 

3
0
6 

3
0
4 

3
0
3 

3
0
2 

1
5
4 

1
5
6 

1
5
7 

1
6
0 

1
5
5 

1
5
8 

1
5
9 
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BAB IV 

INTERPRETASI DATA SPASIAL 

 

4.1. Data Spasial 

Data atau informasi spasial merupakan hasil penafsiran 

data yang dituangkan dalam bentuk simbol sebagai gambaran 

dari keadaan yang sebenarnya. Data atau informasi keruangan 

dapat disampaikan dalam bentuk tabel maupun peta. Informasi 

yang disampaikan dalam bentuk tabel tersebut disebut sebagai 

data atribut atau tabular (terdiri dari kolom dan baris). Namun 

bila data ditampilkan dalam bentuk peta maka disebut sebagai 

data spasial. 

Data spasial ini meliputi data aspek fisik, sosial, ekonomi, 

dan sebagainya. Informasi spasial ditujukan untuk menjawab 

masalah yang terkait dengan pertanyaan apa (what), dimana 

(where), kapan (when), bagaimana (how) dan mengapa (why). 

Data spasial terbagi menjadi dua bagian yaitu data berbentuk 

vector dan raster. Data vector diperoleh dari peta atau dari data 

koordinat yang tersimpan dalam alat Global Positioning System 

GPS, sedangkan data raster dapat diperoleh dari citra 

penginderaan jauh (remote sensing image). Data raster dari citra 

Bab 4 
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penginderaan jauh ini juga dapat digunakan sebagai sumber 

untuk pembuatan data vector. Data vector dibedakan dalam tiga 

jenis utama, yaitu : titik (point), garis (line), dan area (polygon). 

Karena mengandung informasi koordinat dan arah, data ini 

memiliki ketelitian yang cukup tinggi dari kenampakan yang 

sesungguhnya di Bumi. 

Sumber spasial berbentuk digital sangat banyak 

ragamnya, sesuai dengan software yang membuat data tersebut 

ber-ekstensi tertentu. Misalnya, data spasial dari software ArcInfo 

tersimpan dalam suatu coverage yang terdiri dari beberapa file, 

antara lain : *.arc, *.arx, *.bnd, *.aat, *.pat, dan jika ada file utama 

yang hilang atau rusak, maka coverage akan rusak pula. 

 

4.1.1 Format Data Spasial 

Dalam SIG, data spasial dapat direpresentasikan 

dalam dua format, yaitu:  

1. Vektor  

Data vektor diperoleh dari digitasi pada meja digitizer atau 

di scanner lalu hasil digitasi yang dipindah ke komputer 

adalah posisi tiap satuan. 

Model data vektor menampilkan, menempatkan dan 

menyimpan data spasial dengan menggunakan titik-titik, 

garis atau  kurva, atau poligon  beserta atribut-atributnya. 

Bentuk dasar representasi data spasial dalam data vektor 
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didefinisikan dengan koordinat kartesian dua demensi 

(x,y). Dalam model data vektor , garis atau arc merupakan 

kumpulan titik-titik yang saling berhubungan. 

Bentuk data vector ada tiga yakni titik, garis dan polygon. 

Titik (point) hanya mempunyai satu koordinat yakni 

(xn,xy) seperti kota, gunung berapi, triangulasi. Garis (line) 

mempunyai koordinat lebih dari satu dan setiap koordinat 

dihubungkan dengan garis seperti sungai, jalan, dan rel 

kereta api. Area (polygon) mempunyai koordinat lebih 

dari satu dan setiap koordinat dihubungkan dengan secara 

tertutup seperti penggunaan tanah, jenis tanah, intensitas 

curah hujan, dan lain-lain. Sedangkan tiga dimensi 

mempunyai lebih dari satu koordinat dengan basis 

koordinat x,y,z seperti bangunan diagram blok. 

2. Raster  

Data raster (atau disebut juga dengan sel grid) adalah data 

yang dihasilkan dari sistem Penginderaan Jauh. Pada data 

raster, obyek geografis direpresentasikan sebagai struktur 

sel grid yang disebut dengan pixel (picture element). Pada 

data raster, resolusi (definisi visual) tergantung pada 

ukuran pixel-nya. Dengan kata lain, resolusi pixel 

menggambarkan ukuran sebenarnya di permukaan bumi 

yang diwakili oleh setiap pixel pada citra. Semakin kecil 

ukuran permukaan bumi yang direpresentasikan oleh satu 
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sel, semakin tinggi resolusinya. Data raster sangat baik 

untuk merepresentasikan batas-batas yang berubah secara 

gradual, seperti jenis tanah, kelembaban tanah, vegetasi, 

suhu tanah, dsb. Keterbatasan utama dari data raster 

adalah besarnya ukuran file; semakin tinggi resolusi grid-

nya semakin besar pula ukuran filenya.  

Input data raster dapat dilakukan dengan cara Dengan 

CCT (pita kaset) dikonversi ke hardisk. CCT dikoreksi 

dengan koreksi geometrik dan radiometrik. CCT 

berbentuk seperti CD dengan kapasitas CCT 520 mb lalu 

dipindah ke komputer adalah posisi absolut. 

4.1.2 Sumber Data Spasial 

Sebagaimana telah kita ketahui, SIG membutuhkan 

masukan data yang bersifat spasial maupun deskriptif. 

Beberapa sumber data tersebut antara lain adalah:  

1. Peta analog (antara lain peta topografi, peta tanah, 

dsb.)  

Peta analog adalah peta dalam bentuk cetakan. Pada 

umumnya peta analog dibuat dengan teknik 

kartografi, sehingga sudah mempunyai referensi 

spasial seperti koordinat, skala, arah mata angin dsb. 

Referensi spasial dari peta analog memberikan 

koordinat sebenarnya di permukaan bumi pada peta 
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digital yang dihasilkan. Biasanya peta analog 

direpresentasikan dalam format vektor.  

2. Data dari sistem Penginderaan Jauh (antara lain citra 

satelit, foto-udara, dsb.)  

Data Pengindraan Jauh dapat dikatakan sebagai 

sumber data yang terpenting bagi SIG karena 

ketersediaanya secara berkala. Dengan adanya 

bermacam-macam satelit di ruang angkasa dengan 

spesifikasinya masing-masing, kita bisa menerima 

berbagai jenis citra satelit untuk beragam tujuan 

pemakaian. Data ini biasanya direpresentasikan dalam 

format raster.  

3. Data hasil pengukuran lapangan.  

Contoh data hasil pengukuran lapang adalah data 

batasadministrasi, batas kepemilikan lahan, batas 

persil, batas hak pengusahaan hutan, podes, dsb., yang 

dihasilkan berdasarkan teknik perhitungan tersendiri. 

Pada umumnya data ini merupakan sumber data 

atribut.  

4. Data GPS.  

Teknologi GPS memberikan terobosan penting dalam 

menyediakan data bagi SIG. Keakuratan pengukuran 

GPS semakin tinggi dengan berkembangnya teknologi. 
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Data ini biasanya direpresentasikan dalam format 

vektor. 

 

4.2. Data Atribut 

Data yang berbentuk tabel (Data Non Grafis), Data 

“Labelling”/Data Keterangan (Data Non Grafis) 

No. Kecamatan 
Jumlah 

Penduduk 

LUas 

Wilayah 
Kepadatan 

     

     

 

4.3. Kelemahan 

Data Raster 

1. Tampilan atau representasi dan akurasi posisinya sangat 

bergantung pada ukuran pikselnya (resolusi spasial). 

2. Transformasi koordinat dan proyeksi sulit dilakukan. 

3. Secara umum memerlukan ruang atau tempat penyimpanan 

(disk) yang besar di komputer. 

4. Metode untuk mendapatkan format data vektor melalui 

proses yang yang lama, cukup melelahkan (baik proses 

digitasi on screen atau di meja digitizer) 



36   Universitas Negeri Surabaya | Sistem Informasi Geografis (SIG) 

 

36 

Data Vektor 

1. Memerlukan perangkat lunak dan perangkat keras yang 

mahal. 

2. Struktur data vektor lebih kompleks dan prosedur-prosedur 

analisisnya memerlukan kemampuan yang tinggi karena 

sulit dan rumit. 

3. Overlay beberapa layers vektor secara simultan memerlukan 

waktu yang relatif lama. 

4. Proses keseluruhan untuk mendapatkan lama, peta vektor 

seringkali mengalami out of date. 

4.4. Kelebihan  

Data Raster 

1. Compatible dengan citra-citra satelit pengindraan jauh dan 

semua image hasil scanning data spasial 

2. Memiliki kemampuan-kemampuan pemodelan dan analisis 

spasial tingkat lanjut  

3. Gambaran permukaan bumi dalam bentuk citra raster yang 

didapat dari radar atau satelit pengindraan jauh (landsat, 

spot, ikonos, dll.) selalu lebih aktual dari pada bentuk 

vektornya 

4. Overlay dan kombinasi data spasial raster dengan data 

inderaja mudah dilakukan. 
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Data vector  

1. Memerlukan tempat penyimpanan (disk) di komputer yang 

lebih kecil. 

2. Transformasi koordinat mudah dilakukan. 

3. Memiliki batas-batasnyang teliti, tegas dan jelas sehingga 

sangat baik untuk pembuatan peta administrasi, persil 

tanah, dll. 

4. Memiliki resolusi spasial yang tinggi. 
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BAB V 

LANGKAH REPOSISI 

 

Sebelum melakukan reposisi, gambar yang di download dari 

google earth belum memiliki koordinat. Maka yang dilakukan 

adalah mengganti koordinat dengan Decimal Degree atau UTM. 

Buka catalog > klik kanan gambar yang telah disimpan dari 

google earth > properties  
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Setelah muncul hendela raster data set properties, pilih spatial 

refrence kemudian klik edit 

 

Jika sebelumnya gambar disave menggunakan koordinat 

Decimal Degree dan Degree Minute Second maka XY coordinat 

Systemnya dipilih Geographic Coordinte System  
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Kemudian klik World 

 

Kemudian pilih WGS 1984 > Klik Ok 
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Tampilan berikut yang muncul setelah di klik ok 

 



42   Universitas Negeri Surabaya | Sistem Informasi Geografis (SIG) 

 

42 

LANGKAH REPOSISI DMS 

 

1. Aktifkan toolbars Georeferencing, klik Cuztomize > Toolbars 

> Georeferencing 

2. Seret gambar 1 ke layer > perbesar gambar yang ada titik 

koordinat yang telah ada 

3. Klik Add Control Point,akan muncul tanda + yang akan 

diletakkan pada setiap bagian. Dimulai dari kanan atas, 

letakkan tanda + pada bagian gambar di bawah ini 

 

 

Lalu klik kiri > klik kanan >Input DMS of Lon and Lat > 

masukkan angka yang tertera pada bagian kanan atas >OK. 

Longitude diisi dengan garis bujur > pilih E (East) karena 

Sidoarjo berada pada Provinsi Jawa bagian Timur.Latitude 

diisi dengan garis bujur > pilih S (South) karena Jawa Timur 

berada pada subzone 49. 
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4. Ulangi cara tersebut pada titik ke 2, 3 dan 4.  

5. Kita dapat melihat hasilnya melalui View Link Table  

6. Jika keempat titik ikat selesai, simpan dengan klik 

Georeferencing>Update Georefrencing.  

7. Setelah gambar 1 dimasukkan, seret gambar 2 pada layer 

8. Ganti gambar layer dengan gambar 2.jpg  >  Lalu lakukan 

cara reposisi gambar 2 sama seperti nomer 3 sampai 6. Setiap 

mengganti menyeret gambar 3 dan seterusnya jangan lupa 

untuk mengganti layer gambar, jika tidak diganti maka 

gambar tidak akan bertampalan atau menyatu. 
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LANGKAH REPOSISI DECIMAL DEGREE 

1. Seret/drug ke layer gambar yang telah diganti spatial 

refrencenya, jika ada tampilan jendela create pyramids klik 

Yes saja 

 

2. Jika muncul warning klik OK saja 
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3. Zoom titik pertama menggunakan scroll mouse atau klik 

ikon kaca pembesar yang ada tanda plusnya > klik add 

control point 

 

4. Arahkan kursor pada titik pertama yang telah di zoom, 

letakkan di tengah kotak > klik kiri kanan > input X dan Y 
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5. Tulis koordinat ulang dengan X = 112 dan Y = -7. Jika 

menggunakan UTM X = 6 dan Y= 9 > klik ok 

 

6. Akan muncul tampilan seperti gambar di bawah jika sudah 

diklik ok, 1 warna merah menunjukkan bahwa titik pertama 

telah direposisi 
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7. Lakukan hal yang sama pada ketiga titik yang lain. 

8. Jika pada titik ke 2 gambar tiba-tiba hilang saat di klik ok, 

yang harus dilakukan adalah klik simbol bumi atau full 

extent 

 

9. Atau bisa menggunakan cara klik kanan gambar yang ada 

di tabel of conten > pilih zoom to layer 
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10. Maka gambar akan muncul lagi seperti ini 

 

11. Setelah keempat titik selesai diberi titik ikat, maka klik 

georefrencing > update georefrencing 

 

 



   Universitas Negeri Surabaya | Sistem Informasi Geografis (SIG)  49 

 

49 

12. Tampilan dibawah ini adalah gambar yang telah diberi titik 

ikat dan di update. Setelah diupdate, titik ikat yang ada 

akan hilang tetapi tetap tersimpan di link tabel 

 

13. Jika ada salah satu titik koordinat yang salah, bisa diulangi 

input koordinat dengan cara klik vie link table 
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14. View link table yang muncul akan tampil seperti gambar di 

bawah, kemudian hapus titik yang dirasa kurang benar 

pada saat memasukkan koordinat. Di klik titik 4 (misalnya) 

kemudian delete menggunakan keyboard. Ulangi input X 

dan Y 

 

15. Titik ikat yang telah dibuat dapat disimpan dengan cara klik 

save yang ada diview link tabel 
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16. Jadikan satu folder dengan gambar dari google earth > klik 

save 

 

17. Drug/seret gambar kedua pada layer 
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18. Jangan lupa mengganti layer georefrencing dengan gambar 

2 dst. Kemudian ikuti langkah-langkah memberi titik ikat di 

atas hingga selesai dan jangan lupa di update 

 

19. Gambar 1 dan gambar 2 akan otomatis menggabung 
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LANGKAH REPOSISI UTM 

Sebelum melakukan reposisi, gambar yang di download dari 

google earth belum memiliki koordinat. Maka yang dilakukan 

adalah mengganti koordinat dengan UTM. Buka catalog > klik 

kanan gambar yang telah disimpan dari google earth > properties  

 

Setelah muncul hendela raster data set properties, pilih spatial 

refrence kemudian klik edit 
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Jika sebelumnya gambar disave menggunakan koordinat 

Decimal Degree dan Degree Minute Second maka XY coordinat 

Systemnya dipilih projected Coordinate System 

 

Pilih UTM 
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Pilih WGS 1984 

 

Pilih Southern Hemisphere 
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Kemudian pilih 49S untuk wilayah jawa timur, untuk jawa 

tengah 48 dst > klik ok 

 

Tampilan yang sudah diganti spatial refrencenya 

 

Langkah selanjutnya sama dengan input koordinat decimal 

degree 
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BAB VI 

LANGKAH DIGITASI 

 

6.1.  Polyline 

Klik kanan pada folder kerja yang berisi gambar peta 

yang akan didigit. Kita menggunakan polyline, Membuat 

shapefile baru dengan cara, klik kanan pada folder >New > 

Shapefile. 

1. Setelah muncul Create New Shapefile. Name diisi misalnya 

dengan ‘Jalan’ tidak boleh ada spasi. Feature Type pilih 

Polyline karena kita akan membuat garis. Sedangkan Spatial 

Reference klik Edit > Geographic Coordinate System > 

World > WGS 1984 > OK. 

 

 

jalan 

Bab 6 
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2. Bila di dalam peta ada beberapa jenis jalan seperti jalan 

kolektor, jalan arteri, jalan lokal, jalan lain, jalan setapak dan 

jalan TOL. Anda harus memasukkan data tersebut dalam 

Attribute Table. Caranya klik kanan pada shapefile ‘Jalan’ 

yang berada pada Table Of Contents>Open Attribute Table.  

 

3. Pada Attribute table akan menambahkan Field baru 

gunanya untuk menulis ‘keterangan’ dan memasukkan jenis 

jalan. Klik Table Option > Add Field >isi Name dengan 

keterangan > Type diisi dengan Text karena kita akan 

mengisi dengan tulisan >OK. 
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4. Isi kolom keterangan dengan jenis Jalan ( misalnya Jalan Tol, 

Jalan Lokal, Jalan Arteri dll ) 

 

5. Setelah itu klik table of contens> klik Jalan 2 kali > 

Categories > Unique Values> klik value field> pilih 

keterangan > add all values > ok.Dan untuk memilih warna 

dari Jalan, klik 2 kali pada value> pilih color > pilih bentuk 

dan warna sesuai dengan warna peta RBI. 



60   Universitas Negeri Surabaya | Sistem Informasi Geografis (SIG) 

 

60 

 

6. Setelah muncul pada Table Of Contents warna garis tersebut 

dapat dirubah sesuka hati. Melalui doubel klik shapefile 

‘Jalan’ pada Table Of Contents > Symbology > klik garis 

pada Symbol > muncul Symbol Selector > Current Symbol > 

pilih warna sesuka hati > OK. 
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7. Aktifkan toolbar editor, Customize > Toolbars > Editor 

dicentang. Untuk memulai klik ‘Jalan’ pada catalog > klik 

Editor > Start Editing. Apabila muncul seperti gambar 

dibawah ini klik Continue, itu menandakan bahwa shapefile 

yang aktif adalah ‘Jalan’. 

 

8. Sebelum kita mendigit, pastikan semua jenis Jalan ada di 

Create Feature. Apabila belum ada, klik Organize 

Template> next >New Template> centang Jalan saja > next > 

finish > close 

 

Jalan 
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9. Klik jalan lokal terlebih dahulu pada Create Features. Digit 

jalan lokal mulai dari garis batas bawah dengan skala 1 : 500. 

Ketika belum selesai mendigit jalan lokal dan sudah 

terlanjur untuk di klik dobel, anda dapat menghubungkan 

kembali dengan cara meletakkan kursor pada titik terakhir 

mendigit atau Endpoint bisa juga Vertex. 
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10. Bila ada garis digitasi yang miring dan tidak pas di tengah 

sebelum didobel klik, maka cara yang dapat dilakukan 

adalah Ctrl + Z, bila ada yang sudah terlanjur didobel klik 

maka klik Edit Vertices pada toolbar Editor> klik Delete 

Vertex dan kursor diarahkan pada titik yang miring tersebut 

> klik jalan arteri pada Create Features lagi dan digitlah 

pada titik yang sebelumnya. 

 

11. Untuk memudahkan menggeser peta pada saat mendigit 

dapat menekan huruf C pada keyboard, pindahkan kursor 

keatas dan kebawah. Jika pada saat menggeser peta dan peta 

tersebt hilang, jangan panik hal tersebut bisa diatasi dengan 

klik bola dunia atau Full Extent. 

6.2. Polygon 

Sebelum melakukan digitasi, klik kanan pada folder kerja 

yang berisi gambar peta yang akan didigit. Kita tetap 
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menggunakan feature type polyline karena nanti dari polyline 

akan diubah menjadi polygon menggunakan feature Polyline to 

Polygon pada Arc Toolbox. 

1. Membuat shapefile baru dengan cara, klik kanan Folder 

Connection > New > Shapefile. 

 

Muncul jendela create new shapefile, Name = PL; Feature Type: 

Polyline 
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Koordinat sistem dipilih WGS 1984 karena decimal degre/DMS. 

Jika UTM dipilih Projected coordinat 

 

Klik editor > start editing jika memulai untuk digitasi 
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Kemudian muncul jendela start editing klik continue 

 

Editor sudah aktif > klik create feature 
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Kemudian klik PL pada create feature dan line pada 

construction tools 

 

Membuat batas dari keempat titik ikat awal, check apakah garis 

awal dibuat dan garis akhir menyatu apa tidak 
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Jika masih belum menyatu klik edit vertics 

 

Kemudian klik awal pembuatan garis, satukan dengan akhir 

garis. Setelah selesai bisa langsung mendigitasi gambar 
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Digit sesuai kebutuhan 

 

Setelah digitasi selesai klik editor > save edit dahulu untuk 

menyimpan hasil digitasi 
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Selesai di save edit kemudian stop editing 

 

Klik ikon arctoolbox untuk merubah polyline menjadi polygon 
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Pilih data management tools 

 

Pilih features 

 

 

 

 



72   Universitas Negeri Surabaya | Sistem Informasi Geografis (SIG) 

 

72 

Klik Features to Polygon 

 

Muncul jendela feature to polygon. Input featurenya diisi 

polyline_PL 
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Output nya di klik browse 

 

Pilih folder kerja yang sama. Berinama > klik save 
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Semua sudah terisi > klik ok 

 

Tunggu beberapa saat hingga proses selesai 
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Tampilan polygon yang sudah jadi 
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BAB VII 

EDITING 

7.1  Polyline 

7.1.1. Mengubah kembali bentuk (reshape) fitur 

Operasi ini tidak membentuk fitur baru, hanya 

mengubah bentuk fitur yang terpilih berdasarkan garis 

sketsa dan tidak dipengaruhi oleh pemilihan layer target. 

Pilih fitur yang hendak diubah fiturnya. Fitur tersebut harus 

berada dalam workspace yang bisa diedit. 

1. Klik tombol “Reshape Feature Tool”. 

 

2. Selanjutnya buat garis sketsa yang melalui fitur tepilih 

dan memotong pada sedikitnya 2 titik. 

 

Bab 7 
 

EDITING 

https://5758yo.files.wordpress.com/2011/11/02-11-2011-11-34-03.jpg
https://5758yo.files.wordpress.com/2011/11/02-11-2011-11-34-03.jpg
https://5758yo.files.wordpress.com/2011/11/02-11-2011-11-35-08.jpg
https://5758yo.files.wordpress.com/2011/11/02-11-2011-11-35-08.jpg
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3. Akhiri pembuatan sketsa 

4. Fitur yang terpilih selanjutnya mengikuti bentuk garis 

sketsa. Perhatikan bahwa bagian fitur yang mengikuti 

sketsa ditentukan oleh perpotongan antara fitur 

dengan garis sketsa. 

 

5. Tool ini juga dapat digunakan untuk polygon. 

7.1.2. Memotong Garis menggunakan Split Tool 

1. Ikuti seperti gambar dibawah ini 

 

 

 

 

 

https://5758yo.files.wordpress.com/2011/11/02-11-2011-11-36-08.jpg
https://5758yo.files.wordpress.com/2011/11/02-11-2011-11-36-08.jpg
https://2.bp.blogspot.com/-mlm-D40GEE4/WRBk5nqdZ0I/AAAAAAAAAmo/e5wpfhmPUfILhnm55Fl7RIUQOCaM1P3lwCLcB/s1600/1.JPG
https://2.bp.blogspot.com/-mlm-D40GEE4/WRBk5nqdZ0I/AAAAAAAAAmo/e5wpfhmPUfILhnm55Fl7RIUQOCaM1P3lwCLcB/s1600/1.JPG
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2. jika Shp sudah aktif maka akan berbentuk seperti 

gambar berikut 

 

3. Klik Shp, Kemudian klik split tools, dan garis akan 

terpotong, seperti gambar berikut 

 

 

 

 

https://2.bp.blogspot.com/-_6xS3ixr9i0/WRBlNl5msBI/AAAAAAAAAms/lHOsMCYmScsriM4qPeVlffl3sZXZGb_swCLcB/s1600/2.JPG
https://2.bp.blogspot.com/-_6xS3ixr9i0/WRBlNl5msBI/AAAAAAAAAms/lHOsMCYmScsriM4qPeVlffl3sZXZGb_swCLcB/s1600/2.JPG
https://3.bp.blogspot.com/-eV0mjYTUnYQ/WRBl_XPdtcI/AAAAAAAAAm0/HtHm3Y-L75U-DzKpIDJNh47RgwUYq1nagCLcB/s1600/3.JPG
https://3.bp.blogspot.com/-eV0mjYTUnYQ/WRBl_XPdtcI/AAAAAAAAAm0/HtHm3Y-L75U-DzKpIDJNh47RgwUYq1nagCLcB/s1600/3.JPG
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7.2  Polygon 

7.2.1. Trace 

Tahap ini adalah tahap dimana kita harus meneliti 

kembali hasil pekerjaan digitasi yang telah dilakukan 

sebelum melanjutkan tahap berikutnya. Pada tahap ini 

meneliti apakah pekerjaan kita sudah rapi(sudah benar-

benar rapat atau tidak ada cela sama sekali) atau masih 

ada kesalahan dalam proses digitasi. Kesalahan dalam 

proses gitasi umumnya kita tidak tahu sampai mana 

batas yang sedang di digitasi maupun batas yang sudah 

di digitasi. Cara-cara melakukan editing, 

1. Kita perbesar hasil digitasi dengan skala antara 1:1000 

dan 1:50 
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Ada beberapa cara untuk membenarkan atau 

memperbaiki hasil digitaisi tersebut yaitu: 

Cara ke-satu 

2. Klik Editor, > pilih start editing, > buka create features, 

pilih jenis penggunaan lahan yang sesuai, > pilih polygon 

di construction tool, >klik trace di barisan toolbars 

editor,  

 

Kita taruh krusor ke garis penggunaan lahan yang ingin 

di editing, >klik kiri, geser krusor gesuai lubang pada 

hasil digitasi yang kemarin sampai titik awal, >klik kiri di 

titik awal, (peroses pengeseran terserah mau searah 

maupun lawan arah jarum jam) 

Cara ke-dua 

3. Klik Editor, pilih start editing, > buka create features, 

pilih jenis penggunaan lahan yang sesuai, > pilih “ ” 

Auto Complete Polygon di construction tool, 

4. Lakukan digitasi atau editing tapi tidak semua lubang di 

digitasi berikut contohnya, 
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area lingkaran besar itu contoh digitasi editing suatu 

penggunaan lahan, dengan menggunakan cara auto 

complete polygon tidak memerlukan pengeklikan sapanjang 

lubang(kesalahan pendigitasi) tapi sudah tertutupi. 
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5.  Kita gabungkan hasil digitasi yang lama dengan yang 

baru caranya, >klik edit tool,  

 

6.  klik pada penggunaan lahan (sawah tadah hujan) hasil 

editing, >tekan Shift, >klik pada penggunaan lahan 

(sawah tadah hujan) yang lama, >klik editor, pilih merge, 

 

7. Klik OK 
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7.2.2.  Memotong polygon menggunakan Cut Polygon 

1. Tool yang akan kita gunakan adalah tool bar editor yaitu 

lebih spesifikasinya edit tool dan cut polygon tool. 

 

2. Edit tool (kiri) digunakan untuk memilih polygon dan cut 

polygon (kanan) digunakan untuk memotong 

polygonnya. 

Disini saya mencontohkan Kotak 

 

3. Pastikan polygon merupakan area dari wilayah yang 

akan anda digitasi. 

 

https://4.bp.blogspot.com/-iJyJm7euOJ8/WXhH2CFijXI/AAAAAAAABo4/VtIJiX1r6Wc2diI3W20MQcjfws2CE-WbQCLcBGAs/s1600/2017-07-26_14-34-29.png
https://4.bp.blogspot.com/-iJyJm7euOJ8/WXhH2CFijXI/AAAAAAAABo4/VtIJiX1r6Wc2diI3W20MQcjfws2CE-WbQCLcBGAs/s1600/2017-07-26_14-34-29.png
https://4.bp.blogspot.com/-bLZYxvQ-iyY/WXhH1S40rLI/AAAAAAAABos/pmj6CbaiD80kW2hbZ3Zraqsb9YaNyN1FwCEwYBhgL/s1600/2017-07-26_14-32-13.png
https://4.bp.blogspot.com/-bLZYxvQ-iyY/WXhH1S40rLI/AAAAAAAABos/pmj6CbaiD80kW2hbZ3Zraqsb9YaNyN1FwCEwYBhgL/s1600/2017-07-26_14-32-13.png
https://2.bp.blogspot.com/-DiQvsel5euA/WXhH1a6LLvI/AAAAAAAABoo/H22w0MOysAAjMNPfdw4C-Rx7pblcF_X_ACEwYBhgL/s1600/2017-07-26_14-32-40.png
https://2.bp.blogspot.com/-DiQvsel5euA/WXhH1a6LLvI/AAAAAAAABoo/H22w0MOysAAjMNPfdw4C-Rx7pblcF_X_ACEwYBhgL/s1600/2017-07-26_14-32-40.png
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4. langkah awal, kita harus mulai start editing agar polygon 

dapat kita edit. 

 

5. untuk menggunakan cut polygon tool, polygon yang telah 

disiapkan harus dipilih terlebih dahulu dengan 

menggunakan edit tool. Pastikan outline berubah warna 

menjadi biru. Kemudian langsung pilih tool cut polygon 

tool. 

 

6. untuk memotong polygon, harus dimulai dari luar 

hingga keluar lagi di sisi lain. langkahnya seperti kita 

delineasi biasa yaitu click kiri dan pada akhir garis 

double click. 

https://3.bp.blogspot.com/-4gm-Q-6bqjw/WXhH1UVT83I/AAAAAAAABok/vpI59Or2YYszhR1z00FdCf65Esv6Lq5swCEwYBhgL/s1600/2017-07-26_14-33-20.png
https://3.bp.blogspot.com/-4gm-Q-6bqjw/WXhH1UVT83I/AAAAAAAABok/vpI59Or2YYszhR1z00FdCf65Esv6Lq5swCEwYBhgL/s1600/2017-07-26_14-33-20.png
https://3.bp.blogspot.com/-f-n4IlwrkWM/WXhH2FY0bOI/AAAAAAAABo0/WNQvPvds5ScRBQtI6ZFY3tmNkJ47g5UMACEwYBhgL/s1600/2017-07-26_14-34-11.png
https://3.bp.blogspot.com/-f-n4IlwrkWM/WXhH2FY0bOI/AAAAAAAABo0/WNQvPvds5ScRBQtI6ZFY3tmNkJ47g5UMACEwYBhgL/s1600/2017-07-26_14-34-11.png
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7. untuk memotong didalam polygon, anda dapat 

menggunakan cut polygon tool dengan syarat harus 

membentuk lingkaran dan garis delineasinya saling 

memotong. 

 

 

 

https://4.bp.blogspot.com/-2eO85vwvk1k/WXhH2lkfO8I/AAAAAAAABpE/-hmj-B7Y0I0tiyh9mKRVOQ8fSkyBVvN_gCEwYBhgL/s1600/2017-07-26_14-35-38.png
https://4.bp.blogspot.com/-2eO85vwvk1k/WXhH2lkfO8I/AAAAAAAABpE/-hmj-B7Y0I0tiyh9mKRVOQ8fSkyBVvN_gCEwYBhgL/s1600/2017-07-26_14-35-38.png
https://1.bp.blogspot.com/-zzExfDr4XOA/WXhH2m_9nxI/AAAAAAAABpA/TNgbbo8KPSsZvcdvZaWMK0m4G6hHu2f_wCEwYBhgL/s1600/2017-07-26_14-35-48.png
https://3.bp.blogspot.com/-7PFUDjqb1dk/WXhH2u3F2LI/AAAAAAAABo8/NOrrCW7SRt05xpKhYEvpr3G_Z9wo-LdGgCEwYBhgL/s1600/2017-07-26_14-36-07.png
https://3.bp.blogspot.com/-Zi6aUir0NpI/WXhH3LrjPAI/AAAAAAAABpM/wncE3Kb1W0gjHXkG216_NzfOnoykMYNIwCEwYBhgL/s1600/2017-07-26_14-36-23.png
https://3.bp.blogspot.com/-Zi6aUir0NpI/WXhH3LrjPAI/AAAAAAAABpM/wncE3Kb1W0gjHXkG216_NzfOnoykMYNIwCEwYBhgL/s1600/2017-07-26_14-36-23.png
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BAB VIII 

LABELING 

8.1 Labeling Polygon 

1. Untuk melakukan labelling pada penggunaan lahan. Klik 

Table of Contens > klik kanan pada shapefile 

penggunaanlahan atau PL > klik Open Atribut Table 

 

2. Pertama-tama akan membuat kolom baru dengan nama 

(Keterangan). Pada saat ingin membuat kolom baru 

pastikan editor dengan keadaan mati atau apabila sedang 

mendigit di stop editing dahulu. Lalu klik Table Option 

Bab 8 
 

LABELING 
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pada Atributte Table > Add Field. Name diisi dengan 

keterangan > Type diisi dengan Text > OK 

   

3. Select polygon yang akan diberi nama, klik kanan pada 

kolom keterangan > Field Calculator >  
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Apabila muncul seperti gambar di atas tinggal klik Yes saja. 

Maka akan tampil jendela Field Calculator seperti gambar 

di bawah  

  

Isikan kolom keterangan dengan diber awal tanda (“) dan 

diakhiri dengan tanda (“) lalu klik OK. Apabila muncul 

jendela Processing maka label anda sedang di proses. Jika 

sudah akan muncul dalam Tabel seperti gambar. Lakukan 

cara yang sama untuk memberi label yang lain.  
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8.2 Labeling Polyline 

1. Sebelum memberi Id pada data atribut sebaiknya 

menentukan terlebih dahulu mencatat Id yang telah dibuat 

2. Membuat Field baru terlebih dahulu, klik kanan shapefile 

jalan pada Table Of Contens > Open Attribute Table > 

Table Option > Add Field. Name diisi dengan id > Type 

diisi dengan Text > OK 
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3. Mengurutkan value berdasarkan abjad A – Z agar 

mempermudah proses labelling, klik kanan pada tulisan 

keterangan > Sort Ascending.  

 

4. Klik Select by Attribute > maka akan muncul Select by 

Attributes > double klik pada tulisan “keterangan” > klik = 

> Get Unique Values > pilih yang akan diqueri > double 

klik pada jalan kereta api tunggal > Apply. 

5. Dapat menggunakan dua cara untuk mengqueri, dengan 

mengklik pada salah satu value pada keterangan lalu tekan 

tombol Shift +    . seperti gambar dibawah. Cara yang 

pertama seperti no 5. 
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6. Klik kanan pada id > Field Calculator > bila muncul dialogu 

seperti dibawah > klik Yes. 

 

7. muncul Field Calculator > isikan angka 2.2 untuk jalan 

arteri dan jangan lupa memberi petik dua (“2.2”) > OK.  
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8. Lakukan untuk membuat id pada shapefile yang lain.  
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BAB XI 

TRANSFORMASI PETA DIGITAL 

 

Proyeksi secara singkat adalah proses transformasi dari 

ruang tiga dimensi ke dalam peta yang dua dimensi. Proyeksi 

peta melibatkan perhitungan matematika yang 

mengkonversikan data dari lokasi geografisnya yang berbentuk 

bola atau berbentuk bola elipse ke dalam lokasi representasinya 

pada permukaan yang rata (peta).  

Proses proyeksi ini tidak dapat menghindarkan 

munculnya distorsi, paling sedikit pada satu hal dari hal-hal 

seperti: bentuk, luas, jarak, arah dan banyak yang lainnya. 

Karena pengambilan keputusan tentunya harus dihasilkan dari 

peta-peta yang oleh karena proyeksinya telah memiliki distorsi, 

maka seorang pengguna peta untuk tujuan analitis harus tahu 

distorsi pada hal-hal apa yang ditimbulkan oleh masing-masing 

proyeksi dan sampai sejauh mana.  

Dalam membangun basisdata SIG, proyeksi asal sumber 

data sangat perlu diketahui sehingga data tersebut dapat 

diperlakukan sebagaimana mestinya terhadap data-data yang 

lain. Dengan diketahuinya parameter baik proyeksi maupun 

datumnya, maka kita dengan mudah bisa memproyeksikan 

Bab 9 
 

TRANSFORMASI PETA DIGITAL 
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sebuah data ke proyeksi dan datum standard yang kita gunakan 

dalam basisdata SIG kita, sehingga masingmasing data tersebut 

akan kompatibel satu dengan yang lainnya. 

 

Beberapa contoh 

proyeksi yang 

sering 

dipergunakan di 

Indonesia adalah: 

Proyeksi  

Tahun Semi Major Axis (a) Semi Minor Axis (b) 

Bessel  1841  6377397.155  6356078.96284  

Indonesia 74  1974  6378160  6356774.5  

WGS 84  1984  6378137  6356752.314  
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BAB X 

LAYOUT PETA 

 

1. Klik View > Layout View. Maka akan muncul seperti 

gambar di bawah. 

 

 

 

 

Bab 10 
 

LAYOUT PETA 
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2. Mengatur kertas yang akan digunakan, klik File > Page and 

Print Setup > Paper: A4> Orientation: Landscape. 

  

3. Memunculkan toolbar Drawing dan Layout dengan cara 

klik Customize >centang Draw dan Layout. 
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4. Membuat grid dengan cara klik View > Data Frame 

Properties > Grid > New Grid > Grid and Graticule 

Wizard > Measured Grid > Next > Create a Measured Grid 

> Appearance pilih Tick Mack and Labels > Coordinat 

System klik Properties >pilih Project Coordinat System > 

UTM > WGS 1984 > Southern Hemisphere > WGS 1984 

UTM Zone 49S > OK > Interval X diganti dengan 5000 dan 

Y juga sama >OK > Next > Next > Finish. Maka akan 

muncul seperti gambar di bawah ini. 

 

5. Klik Properties pada Data Frame Properties > klik Intervals 

X dan Y diganti disesuaikan > klik Labels > Additional 

Properties >muncul Grid Label Properties > Number 

Format >pada Numeric: Rounding pilih Number of 

significant digits pilih 6 >OK. 
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6. Membuat kotak dengan cara klik Rectangle pada toolbar 

Draw. 
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7. Memberi warna pada kotak yang telah dibuat dengan cara 

klik kanan >Properties > Symbol > Fill Color diganti warna 

sesuka hati >OutlineColor warna hitam dengan Outline 

Width 3 > OK. 

 

 

 

 

 

 

8. Menuliskan text di dalamnya dengan klik Text pada toolbar 

Draw.  
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9. Mengedit tulisan yang telah selesai maka klik kanan 

>Properties >klik pada Text. Mengedit tulisan juga bisa 

dilakukan dengan klik Chage Symbol> muncul Symbol 

Selector >ganti sesuai keinginan >OK. 

 

10. Menyisipkan gambar dengan cara klik Insert > Picture. 
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11. Menyisipkan legenda dengan cara klik Insert > Legend 

>muncul Legend Wizard >masukkan shapefile yang telah 

dibuat ke Legend Items > Next > Legend Title dikosongi 

saja >Next > Finish > OK. 

 

12. Mengedit legenda agar terlihat lebih rapi seperti 

menghilangkan tulisan ‘keterangan’ dengan cara, klik kanan 

>Convert to Graphic > Ungroup >Bila telah selesai 

mengedit, klik yang telah di edit klik kanan >Group. 
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13. Mengedit tulisan juga sama dengan cara no 7. 

14. Menyisipkan mata angin dengan cara klik Insert > North 

Arrow >pilih mata angin sesuka hati >OK. 

 

 Klik kanan pada symbol di kertas map, >pilih propertis,  

 muncul jendela north arrow propertis, >pilih north arrow, >pilih 

symbol (untuk memberi keterangan U,S,B, dan T), muncul 

jendela symbol selector, >pilih edit symbol, muncul jendela 
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symbol property symbol, >klik add layer (klik add layer 

sebanyak empat, disetiap layaer berisi U, S, B, T “font size 10” 

jadi jumlah ada 5 layer)  

 atur dari setiap layer “ U ” dan “ S ” diatur di bagian offset Y, 

keterangan “U” bagian Y diganti 30, keterangan “S“ bagian Y 

diganti -30, 

 atur dari setiap layer “ B ” dan “ T ” diatur di bagian offset X, 

keterangan “B” bagian X diganti -30, keterangan “T“ bagian X 

diganti 30, 

 

15. Menyisipkan skala batang dengan cara klik Insert > Scale 

Bar >pilih skala sesuka hati >OK.  

16. Untuk mengedit skala batang klik kanan Properties 

>muncul Scale Bar > Scale and Units > Scale>Number of 

Division adalah 2, sedangkan Number of sub division 
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adalah 4 >When Resizing pilih Adjust division value. 

Untuk unit kita menggunakan skala dengan satuan 

Kilometer dengan mengganti Sub division unit dengan 

kilometres, bila tulisan kilometres terlalu panjang dapat 

dipersingkat dengan hanya menuliskan Km di Label. 
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17. Klik Numbers and Marks yang diganti hanya frequency 

pada Marks dengan menggunakan division and first 

subdivision > OK 

18. menyisipkan skala angka dengan cara klik Insert > Scale 

Text >pilih skala sesuka hati >Properties > muncul Scale 

Text >pilih style yang Absolute > OK. 

 

19. Menyisipkan inset dengan cara klik Insert > Data Frame 

>bila sudah muncul kotak dengan nama New Data Frame> 

klik kanan Add Data >arahkan pada folder kerja yang berisi 

gambar peta sidoarjo.jpg > OK > klik View>Data View> 

untuk memberi batas peta yang didigit > masukan garis 

batas yang telah dibuat > buat shapefile baru dengan 

filetype polygon, diberi nama INSET > tutup bagian yang 

bukan didigit > bila sudah klik View>Layout View. 
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108   Universitas Negeri Surabaya | Sistem Informasi Geografis (SIG) 

 

108 

 

20. Simpan layout dengan format JPEG dengan cara klik File > 

Export Map > Name: diisi dengan nama, sedangkan File as 

Type pilih JPEG > OK. 
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21. Rapikan layout sesuai keiinginan  
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Unsur-unsur Kelengkapan Peta : 

1. Judul Peta :  untuk mencerminkan isi dan jenis peta yang 

dibuat. 

2. Grid : untuk menentukan koordinat lokasi suatu 

tempat. 

3. Skala : untuk mengetahui jarak yang sebenarnya. 

4. Mata angina : untuk mengetahui arah peta. 

5. Inset :  untuk memperjelas salah satu bagian dari 

peta yang dipetakan. 

6. Legenda : keterangan dari simbol peta agar lebih 

mudah dipahami pembaca. 

7. Tahun peta  : untuk mengetahu periode pembuatan peta. 

8. Pembuat peta : untuk menentukan kebenaran dari suatu 

peta 

9. Sumber Peta :  Agar pembaca mengetahui dari mana 

sumber peta diperoleh. 

10. Garis Tepi : untuk merapikan dan mempercantik 

tampilan peta. 


